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Reports Module  
 
The Reports module contains standard Web Work reports and a report writer to create customized reports 
that you can build yourself. This Chapter describes how to use the Web Work Reports module. 
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22.1 Overview of the Reports Module 
 
Web Work has two report types: 
 
Standard Reports – These reports have standard selection screens to filter your data to the desired result. Each 
module in Web Work has an associated set of Standard Reports. 
 
Custom Reports - Web Work has a built-in report writer which allows you to create your own reports quickly and 
easily. The entire Web Work database is available to you via the custom report writer. The report writer also has 
an export feature that allows you to bundle your data in XML format for sending to other web based applications 
on the internet or on your intranet. Reports built in the custom report writer can be published to modules. The 
reports can be restricted for individual’s use by data division. 

 
•  To access the Reports module, click on the Reports button on the left hand side of the screen. 

•  A screen similar to the one pictured below will open: 

 
 

•  The left hand side of the screen lists the modules, which contain standard reports.  Click on   any module 
name in the list to view a list of the standard reports for that module. 

•  The right hand side of the screen listed under Custom is where you find the Report Writer.  Click on this link to 
open the Web Work custom report writer. 
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22.2 Viewing Reports 
 
Web Work Reports can be viewed either from the Report Module or from any other module. When viewing from 
the Report Module, you will have access to all reports. When viewing from a module other than the Report 
Module you will only see the reports assigned to the module. In both cases you will be restricted to reports in your 
data division, if the data division feature is turned on. 
 
22.2.1 Viewing Standard Reports from the Report Module 
 
To view a Report from the Reports Module: 
 
•  Click on the Reports button on the left hand side of the screen to access the Reports module. The resulting 

screen is shown below. 

 
 
 

•  Click on the applicable module listed under the heading Standard to view a list of the standard reports and 
custom reports assigned to that module. Our example shows the Equipment standard reports being chosen. 

 
 
 

•  Below we see the result from choosing Equipment Reports. Notice how both standard and already written 
custom reports assigned to Equipment are available. 
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•  Any of the Standard Listing Reports like “Equipment List” will print ALL records in your Equipment Listing. Be 
warned, that means ALL your records and if you have hundreds or thousands of Equipment records it is best 
not to use the List reports. It is recommended you use the Query Driven reports instead. In fact, in most cases 
we recommend you use the Query Driven Reports to ensure you only retrieve reports relevant to your report 
query. 

•  To view a Custom Report, just click the report name under the Custom heading and you will see the report. 
These reports generally have built-in filters. 

•  To view a Standard Report we recommend you click Query Driven under the Standard Report heading. 

 

Remember to use the Query 
Driven report option to limit the 
records you are retrieving. That 
way you only get want you want. 
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•  You should now see the screen as shown below. By entering selection criteria, you can filter the data on your 
report to see only pertinent records. 

 

•  Section 1 is where you can enter the filters. You will be presented with different fields to filter depending on 
the report you choose to run. We have provided an example above that shows a filter by Location = ‘001a’ 
and by Subtype = ‘CLEAN’. In plain language, we are looking for cleaning equipment at location 001a. In the 
example, both criteria must be met for an equipment record to appear on the report. 

•  Section 2 allows you to view and edit the SQL WHERE clause that is used to filter your data from the Web 
Work database. Any valid WHERE clause can be used. As an example, if you wanted to changed the report 
filter to include both Location ‘001a’ or cleaning equipment you could change the AND to an OR by editing the 
SQL String to read: Location='001a' OR MRType='CLEAN' . By doing this, only one of the two criteria needs 
to be met for the equipment record to appear on the report. 

•  Section 3 allows you to sort your report by a field. Just click the drop down arrow to choose from the list. 

•  Section 4 is where you choose the report you want to view. Once you have entered your selection criteria, 
click the report you want to view. 
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•  The example below shows the Equipment List Report using the selections for cleaning equipment at location 
001a. 

 

 

 
To print the report, go to the File Menu at the top or your browser and click File then Print.  
 
 

 
22.2.2 Viewing Standard Reports from Other Modules 
 
All modules have Standard Reports in them. All modules can also have Custom Report Writer Reports assigned 
to them. 
 
•  To access the reports menu from a module, open the module and click on the Tools menu.  

•  The first item at the top of all Tools menus is Reports. Click Reports to access the Reports Menu.  

•  You should now see the same reports menu as accessed from the Reports Module. Please refer to the 
previous section for detailed instructions on how to view these reports. 
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22.2.3 Viewing Custom Reports from the Report Writer Module 
 
To view a Report from the Reports Module: 
 
•  Click on the Reports button on the left 

hand side of the screen to access the 
Reports module. 

•  Under the Custom heading, click Report 
Writer as shown here:  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
•  To see all reports available to you 

click the “View All Reports” button.  

•  To see just your reports (ones that 
are owned by you) only click the”My 
Reports Only” button. 

•  To run a report, click the name of 
the report. We are showing the 
Equipment by Location report being 
chosen here. 
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22.2.4 Viewing Custom Reports from Other Modules 
 
All modules can also have Custom Report Writer Reports assigned to them. 
 
•  To access the Custom Reports menu from a module, open the module and click on the Tools menu.  

•  The first item at the top of all Tools menus is Reports. Click Reports to access the Reports Menu.  

•  To view a report, simply click the report name under the Custom heading. 

 
 
22.3 Publishing Reports 
 
All reports in Web Work can be printed. The first step in printing a report is to view it. For information on viewing 
reports, please see the Viewing Reports sections above.  
 
Reports should be viewed on screen before printing to ensure you get want you want. A quick glance over the 
screen to the end of the report before printing can save a great deal of time (and paper.) 
 
 
22.3.1 To Print a Web Work Report: 
 
Choose the report you want to Print and View it as described in the Viewing Reports sections above. 
 
•  To print the report, go to the File Menu at the top 

or your browser and click File then Print as shown 
here 

 

 

 

 

 

 

 

•  Below we see a typical Toolbar from Microsoft Internet Explorer 6.0. The example shows how you can print in 
a single click using the printer icon. By clicking the printer icon as shown below you can print the report 
directly to your default printer. 

 
 
 

Click here to Print. 
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22.3.2 To Email a Web Work Report: 
 
 
•  Choose the report you want to Email and 

View it as described in the Viewing Reports 
sections above. 

•  To Email the report go to the File Menu at 
the top or your browser and click File then 
Send and E-mail as shown here. 

 

 

 

 

•  Below we see a typical Toolbar from Microsoft Internet Explorer 6.0. The example shows how you can email 
in a single click using the email icon.  

 
 
 

Click here to email. 
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22.3.3 To Export a Web Work Report to Microsoft Excel or Word or Other: 
 
 
•  Choose the report you want to Export and View 

it as described in the Viewing Reports sections 
above.  

•  Then click Select All on the Edit Menu to 
prepare the report for export. The report should 
now be highlighted and it must stay that way 
until the next step is completed. 

•  Go to the Edit menu again and click Copy to 
copy the report to the clipboard.  

•  The final step is to open Excel or Word and go 
to the Edit menu and click Paste. This will 
publish your report in Excel or Word, depending 
on your preference. 

 

•  Below we see a typical Toolbar from Microsoft Internet Explorer 6.0. If you have these icons available to you, 
you may be able to directly export the report with a single click by clicking on the menu option with the name 
you wish to export to. For example, click Edit with Microsoft Excel to export the report to launch Excel and see 
your report. 

 



Web Work User’s Manual 
 
 
 

   
 

Reports 
 

 
 22 - 11 

 

22.4 Custom Report Writer 
 
The Web Work Custom Report Writer can be used to extract and analyze any data you have entered in your Web 
Work system. Reports can be created and then distributed to be used in specific modules by Web Work users. 
Data can be secured by taking advantage of the Web Work Data Division feature. This means data can only be 
viewed by a user on a report if he or she has been granted rights to the data/information. For more information on 
Data Divisions, please see the Administration Module Chapter. 
 
 
22.4.1 Creating New Custom Reports 
 
To create custom reports: 
 
•  Click on the Reports button on the left 

hand side of the screen to access the 
Reports module. 

•  Click on the Report Writer listed under 
the heading of Custom to open the 
custom report writer. 

•  A window similar to the one shown here 
will open.  

•  Click on the 
 

 button to create a new 
report. 

 
 
 
 
 
 
 



Web Work User’s Manual 
 
 

   
 

Reports 
 

 
 14 - 12 

 
 
The Web Work report editor screen will open as pictured below: 
 

 
 
Step 1 – Setting up the Report: 
 
 The Custom Report Writer incorporates three frames; left, right and bottom.  The left frame contains report details 
and will determine which table information is available to the right frame: 
 
•  Start by typing the title you want for your report in the Report Title field. 

•  The Owner field will be defaulted to the user who is logged in. You can leave it as is or change it if you want 
to write a report for other users and assign it to them. The Owner field will determine who can see the report 
when setting the Available To field. 

•  Available To is used to filter who can see the report. It has three options: 

Owner Only – means only the owner can see this report. 
 
Lower Division Level – means users assigned to a data division lower than the than the division    
entered in the Division field can see this report. 
 
Owner and Higher Division Level – means only users with a division higher than the division   
entered in the Division field and the Owner can see this report. 

Left Frame Right Frame

Bottom Frame
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•  To create a Summary Report click the 

Summary Report box.  This will omit 
lists of records and only show sums 
and totals on the report. 

•  Set the Module field to the module 
you want to make the report available 
in. This will make it appear on the 
Report Menu in the module you 
choose. 

•  The Tables window allows you to 
choose the table or tables you want to 
extract your data from for your report. 
To choose multiple tables, hold down 
the Ctrl key on your keyboard and 
click the tables with your mouse to 
highlight them. If you choose more 
than one table you will be required to 
set the links between the tables as 
described later below. See the Setting 
Joins on Multiple Tables section 
below for more details. 

•  You can change the tables you have chosen later by clicking the Change Table button, highlighting the tables 
you want and clicking the Save button. Remember to click ALL the tables you want on the report including 
ones you already had on the report. Any table not chosen will be dropped form the report along with their 
corresponding fields. 

•  The Comment field lets you add a message that gets printed at the bottom of the report. 

 
•  If Data Divisions is implemented, choose the appropriate division to which this report will be made available 

to. The Division field will determine who can see the report when setting the Available To field. 

•  When you click on the Save button, the right frame will be populated with the selected table’s column 
headings (fields.)  The Web Work report editor screen will now open as pictured (on next page): 
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Step 2 – Adding Fields to the Report 
 
•  To add a single field to the report, select Add Fields radio box and click on the field highlight it and then click 

the 
 

button 

•  To add many fields to the report at one time, select Add Fields radio box and hold down your Ctrl key on the 
keyboard and at the same time click the fields you want with your mouse. When you have the fields 

highlighted that you want on your report, click the 
 

button. 

•  You can add fields to your report at anytime using these methods. Note that the Mode must say Add Fields to 
add fields to your report. If it does not you need to click the Add Fields button. 

•  Once the report has been saved, the right and bottom tables will appear with the report structure.   

•  The right frame will determine which field information is available for the bottom frame. 

•  The bottom frame will determine the output of the report. 
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Step 3 – Formatting the Fields 
 
The next step is to setup the filters and formatting of your fields.  The bottom table is made up of rows that pertain 
to the report fields and columns that refer to functions.  

•  The functions can be 
used by clicking on a 
cell in the table.  

•  The functions are 
described below: 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

Label  
 
•  This heading allows you to change the 

name of the current field label for the 
selected column to the label of your 
choice.  This label is what will be printed 
on the actual report.  

•  To edit the label, click on the applicable 
label.  This will open the Change Field 
Label screen as seen here. 

•  Enter a new field label in the New Label 
field and click Save. 
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Table 
 
The Table column tells you the Web Work table that the field is from. This will become more important 
when we explore having multiple tables on a report later in this chapter. 
 
Field 
The Field column tells you the name of the field in the Web Work database.  
 
Col 
The Col column denotes the order the field will appear on the report. One is the left most field and it goes 
up as you go to the right. This is a read only column and gets set using the Up and Dn columns. 
 
Up 
This function should be used to order the fields on your report. Clicking once on an Up cell will move the 
row up in the column order.  
 
Dn 
This function should be used to order the fields on your report. Clicking once on a Dn cell will move the 
row down in the column order.  
 
Sort 

 
 The Sort function allows you to sort the fields used on your report. By default the sort column will display 
NONE in the on cells.  Click once to change the order to Ascending, click a second time to change the 
order to Descending and the third click back to NONE. If you set more than one field to sort then Web 
Work will sort them in the order of the Col column. 
 
Criteria 

 
This column will be populated with any criteria selected in the Set column. 
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Set 

 
The Set column allows you to apply a filter to the records on your report.  Click on the  cell in the row 
corresponding to the field you want to filter on. You should then see the screen as shown here. 
 
Click on the down arrow to select a criteria from the following choices: =, <>, =>, <=, <, >, Between, Like 
or Not Like. 
 
= Equals 
<> Does Not Equal 
=> Equal To or Less Than 
<= Equal To or Greater Than 
In  Means that the field has the 

criteria in it. If you select IN, 
separate each value with a 
comma. 

Between If you select Between, insert two 
values separated by a comma. 

  

Like If you select LIKE or NOT LIKE, 
use % as wild card character. 

Not Like If you select LIKE or NOT LIKE, 
use % as wild card character. 

Is Null Means the field is empty. If you 
select LIKE or NOT LIKE, use % 
as wild card character. 

Is Not 
Null 

Means the field is not empty. If 
you select LIKE or NOT LIKE, 
use % as wild card character. 

 
 Width 
 

The Width function lets you set the width of a column. The setting is shown in pixels. This means the field 
columns are set up as a percentage of the width of your monitor setting. Basically, the report columns will 
appear wider on the bigger monitor that has a higher resolution. Use the – and + columns to set the width. 

  
 + 
 
 Click on the + sign in the cell on the row of the field you want to increase the width of.   
 
 - 
 
 Click on the - sign in the cell on the row of the field you want to decrease the width of.   
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 Total 
  

Use the Total function to Sum or Count the records in the column .By default, the total column will display 
NONE.  To add a total, click once to change the total to SUM, click a second time to change the total to 
COUNT or click a third time to reset the total back to NONE. 
 

 Group 
  

The Group feature lets you set the fields you want to group on. By default, Group is set to N (No).  To set 
the information in this column to group, click once to change the N to Y (Yes) or click again to reset this 
column to N.   
 
By using Group and setting the Total value to Sum or Count, the report will sub-total by the group and 
give a grant total at the bottom. 

 
 Visible 
  

Use the Visible function to hide or unhide fields on the report. You may want to hide a field when you 
want to put criteria on it but not view it on the report. By default, Visible is set to Y.  To hide the column on 
the report, click once to change the Y to N or click again to reset this column to Y. 
 

 Delete 
  

To delete this column from your report click on the . 
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22.4.2 Setting Joins on Multiple Tables 
 
Step 4 – Setting Joins 
 
If you choose more than one table on a report you must set up a join that develops a relationship between the two 
tables. If, for example, you chose to create a report using the Work Order and Equipment tables you would need 
to relate them somehow. You would do so by relating the Equipment Id as common between the two tables.  
 
Below we demonstrate how to set a join between two tables: 
 
•  Open the Report Module and start a new 

report as described in the previous 
section. We will describe setting up a 
report that uses the Work Order and the 
Equipment tables. When you get to the 
Table window, highlight both the 
Equipment table and the WorkOrder table 
to add them both to the report. 

•  To set up a join you need to put the right 
top window in Join Table Mode. To do 
this, click the Join Tables button. You can 
toggle back to Add Field mode by clicking 
the Add Fields button. 

•  To choose the fields you want to join 
double click them which will send them 
down to the Join Field 1 and Join Field 2 
text boxes as shown here. 

•  The Join Type field must be set next to determine the way you want to relate the records. The three types of 
joins are described as: 

Only matching records:  only records that are in the first table and also the second table that have a 
match. For example, if you choose to link the Work Order table to the Equipment table by the 
Equipment code, you would have to have the same equipment code in both tables before the 
record(s) would appear on the report. 
 
All Records from the first table, matching from second: all records from table 1 are returned. Only 
records from table 2 which match the join criteria are returned. Table 1 records which have no match 
in table 2 will have tabled 2 fields displayed as null values. 
 
All Records from the second table, matching from first: all records from table 2 are returned. Only 
records from table 1 which match the join criteria are returned. Table 2 records which have no match 
in table 1 will have tabled 1 field displayed as null values. 

 

•  Click on the  button to set the join type you selected.  Links are show below the table field labels. 

For Multiple tables, you must create proper LINKS for each table for your report to function properly. 
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•  Once links are created, you will see them in the 
window as shown here.  

•  You can delete a link by clicking the trash can icon 
beside it. To change a link you must delete it first 
and then create it as describe above. 

22.4.3 Calculated Column Setup 
 
Step 5 – Calculate columns 
 
A Calculated column is used to add fields 
together in one report column to perform a 
computation.  All of the information for the 
calculated column is entered in the right 
frame of the report writer.  
 
 
•  First you need to make sure you are in 

Add Fields mode as indicated in the top 
left corner on the window. If you are 
currently in Join Table mode, click the 
Add Fields button to set your session to 
Add Fields mode. 

•  Type the name you want for your 
Calculated field in the Calculated Col 
Label text box. 

•  Double click the first field you want to use. The field name should populate in the Calculated Field text box.  

•  Add the Operator you want to use to calculate the fields with. You can use most the basic math signs like +, -, 
*, /. For the example here we have chosen the plus sign to add the field together. 

•  Double click the second field you want to use and it should populate in the Calculated Field text box also. 

•  You can add more fields to this calculation by repeating the last three steps. 

•  When ready click the Add Field button to add the new calculated field to your report.  

•  Once the calculated column is moved to the bottom frame, additional characteristics may be added; such as 
SUM or criteria. 
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22.4.4 Report Output 
 

Step 6 – Running the Report 
 
Web Work offers different choices for executing your report. Output can be altered with features found at the 
bottom of the report writer screen. 
 
 Save Button 

  
The Save button saves your reports. Remember to save frequently to avoid loosing any work. 
 

 Run Report Button 
  
The Run Report button lets you preview your report. You can do this from time to time as you write 
you report so you can see it being built.  
 

 Print XML Button 
  
The Print XML button will publish your report in XML format so you can send it to other web based 
application for importing. 
 

 Modify SQL Statement Button 
  
The Modify SQL Statement button allows you to view and modify the SQL statement the report uses 
to query the database. Click the Modify SQL Statement button to open the SQL Statement window. 
Here you can view the SQL Statement created by the report writer. You can also modify the SQL 
Statement to your liking as long as it is a valid SQL statement and the tables and fields you refer to 
have been made available to the report. 
 
Note: when you click the Save Report button Web Work re-builds the SQL Statement based on the 
settings in the windows above. If you changed the SQL Statement manually it will be over written. To 
avoid this from happening we suggest you copy your modified SQL Statement to a text editor like 
Notepad and save it there. That way you can always copy and paste it back into the Web Work SQL 
Statement window is need be. 
 

 Close Button 
  
The Close button closes the report writer screen. Remember to click the Save Report button first to 
ensure your work is saved. 
 
Print SQL Statement On Report 
  
Click and check the Print SQL Statement on Report box to have the SQL Statement printed at the 
bottom of your report. This is sometime handy for people viewing the report to get an idea of how the 
data was extracted and filter etc. 
 
Print Report Author On Report  
 
Click and check the Print Report Author on the Report box to have the Owner printed at the bottom of 
your report. 
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22.4.5 Editing Custom Reports  
 
•  Click on the Reports module on the left hand side of the screen to access the Report Writer. 

 

 

 
 
•  Click on the RADIO button beside View All Reports or My Report Only to select which reports you wish to 

view. 

 

•  Click on the  button beside the report you wish to edit. This will open the report you selected in Report 
Editor mode. 

•  Make any applicable changes. 

Click on the Report Title 
to run the report. 

To make a copy of 
the report, click on 
duplicate.  Click 
on the respective 
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22.5 Reviving Deleted Reports 
 
From time to time a report gets deleted and we later decide we want it back. Web Work has a feature to 
accomplish this. To revive a deleted report:  
 
 
•  Click on the Reports module on the left hand 

side of the screen to access the Report Writer. 

•  Under the Custom heading, click Revive/Erase 
Deleted Reports. 

•  Click the Revive icon beside the report you want 
to revive. The report can now be found on the 
Custom Report listing. 
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22.6 Duplicating Reports 
 
Web Work has an easy to use feature for duplicating or copying an already written report. What follows are 
instructions for duplicating a report:  
 
 
 
•  Open the Report module and Click under the 

Custom heading on Report Writer to open the 
Report Writer. 

•  Find the Report you want to duplicate and 
click duplicate to the right of the report name. 
We see the WO Summary report being 
duplicated in the screen example shown here. 

 

 
 
 
 
 
 
 
 
 
 

•  Enter the name you want for your new report in 
the New Report Title text box.  

•  Set the Report Owner and assign who it is 
available to. Please see the section titled, Creating 
New Custom Reports above for details on these 
settings.  

•  Click Duplicate to make a copy of the report under 
the new report title. You will find the report on the 
Custom Report menu. 
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22.7 Adding Your Logo to Reports and Work Orders 
 
 
The default logo for all reports in the Web Work system is the Web Work logo.   
 
To change this to your company’s logo follow these steps: 
 
•  Create a logo that is a maximum of 200 pixels wide by 100 pixels high. 

•  Ensure the logo is in GIF format 

•  Name the logo file: logo.gif 

•  Copy the logo into the webwork/images directory. 

 
 
If Data Divisions are being used, please refer to the Admin chapter and the Division Defaults setup 
section. 
 
 

 


